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iMapBC Training Manual
1.0
1. Introduction to iMapBC
This user manual offers an in-depth review of the iMapBC tools, as well as new and advanced features
included in iMapBC. This document helps guide you through the iMapBC training workshop and
provides a comprehensive description of the web application's features. This manual is for the new
iMapBC HTML5 map service, not the iMapBC Silverlight map service (to be retired in 2017).
iMapBC is designed to handle most people’s needs for simple mapping and GIS functionality, including
viewing and selecting data, building simple query statements, printing, drawing, saving, and uploading
files.
iMapBC is designed for users who do not have formal GIS training; however, this web application still
acts as a functional tool for experienced GIS users.
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1.1. Differences between iMapBC HTML5 and iMapBC Silverlight
The main difference between the iMapBC HTML5 and the iMapBC Silverlight mapping services is
compatibility. iMapBC Silverlight requires a plug in and is not compatible with certain web browsers
(e.g. Google Chrome).
There are also tools that are new to iMapBC HTML5 and certain tools available in iMapBC Silverlight that
are not available in the iMapBC HTML5 version.
The following tools and functions are only available in iMapBC HTML5, not iMapBC Silverlight:
 Toggle Labels (layer options)
 Customize Labels (layer options)
 Provincial Layer Download (in the Export tab)
The following tools and functions are only available in iMapBC Silverlight, and not iMapBC HTML5:
 External Map Layers (in the Maps & Data Sources tab)
 Layer Drawing Order (in the Maps & Data Sources tab)
 View Results (in the Reports & Printing tab)
 View Selected (in the Reports & Printing tab)
 Advanced Query Tool (in the Analysis tab)
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2. iMapBC Basics
Starting iMapBC, getting help, interface layout, new features, saving projects

2.1. Starting iMapBC
To start the iMapBC application, open a web browser and go to the DataBC Geographic Services home
page: http://www2.gov.bc.ca/gov/content/data/geographic-data-services. Click iMapBC.

In the iMapBC window, there are several iMapBC options:
 Launch iMapBC 4 Mobile
 Launch iMapBC 2 Silverlight (Public)
o The Silverlight version is not covered in this manual.
 Launch iMapBC 2 Silverlight (Restricted Access)
o The Silverlight version is not covered in this manual.
 Launch iMapBC 4 Mobile (Restricted Access)
To open the iMapBC HTML5, click either the Launch iMapBC 4 Mobile option (for public users) or Launch
iMapBC 4 Mobile (Restricted Access) option (for restricted users – including Government Staff).
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2.2. iMapBC Layout
The iMapBC interface has five main sections.

Toolbar
Tabs

Toolbar
Map Window
Information
Panel

Overview Map

Toolbar Tabs: The toolbar consists of tabs that categorize the tools into high-level groups: Home tab
(includes navigation tools), Data Sources tab (add information to the map), Export tab (print, export
images and data), Sketch tab (draw on the map), and the Find tab (identify and query map layers).
Toolbar: In each tab, the toolbar contains numerous tools that are organized into ‘tool groupings’ based
on their functions.
Information Panel: The information panel displays different kinds of information as you interact with
the map. For example, it displays ‘Map Layers’, where you can select which layers of the map to hide or
show, and the ‘Results List‘, which lists map features when you perform a search or use the ‘Identify’
tool.
Map Window: This window is where you interact with the map by zooming, panning, or right-clicking to
get more information.
Overview Map: The overview displays a thumbnail of the whole map, with the current view shown as a
small square. The Overview Map can be minimized by clicking the arrow at the bottom left of the map
window. Also, dragging the current view box can be used to navigate to a different location in the map
window.
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2.3. Other Features in iMapBC
The iMapBC interface displays the following features.

Search Box
Display / Hide
Toolbar Icon

‘I want to…’
Menu

‘Right-Click’
Menu

Information
Panel Icons

Base Map
Options

Coordinate
Options
Scale Input Box
Scale Bar

‘I want to…’ Menu: A menu of shortcuts to frequently used tools.
This menu tries to anticipate what you will want to do most often.
This includes the ‘Save’, ‘Save as’, and ‘Open’ project tools.
Search Box: Type the name of a feature or a street address into
this box to search for it on the map.
See Exercise 1 (in Appendix A): Search for an
Address for an example of this function.

Display / Hide Toolbar Icon: This icon shows or hides the toolbar
when clicked.
Information Panel Icons: These icons are used to switch between
various types of information that is displayed in the ‘Information
Panel’, including the iMapBC home screen, map layers, and search
results.
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Base Map Options: Click to display different base map options, including satellite imagery. This will
change the map background image that is shown in the map window.

Coordinate Options: Allows the user to view and change the default
coordinate system shown in iMapBC. The coordinates system in this
section relates to the map centre location.
Scale Input Box: Allows the user to change the current map scale from a
set of predefined map scale option.

Scale Bar: Shows the scale bar for the map window.

2.4. Right-Click Options
Right click in the map window to display various options and tools based on the location clicked in the
map window.
The coordinates at the top of the menu correspond to the
clicked location in the map window.
Find data on the map: Allows the user to run an Identify on any
added layers at the location clicked.
Draw a Point: Draws a point in the map window.
Plot a Coordinate: Creates a coordinate callout in the map
window.
Add Some Text: Allows the user to enter text in the map
window.
Center the Map Here: Centers the map window to the clicked
location.
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3. Save and Open Projects
iMapBC projects are saved to a server where they can be retrieved.
Save and Open session options can be accessed on the ‘I want to…’
menu.

3.1. Save a Project
You can save a project using either the ‘Save’ or the ‘Save as’ tools.



Choosing ‘Save’ saves your work to a previously named saved project
Choosing ‘Save as’ brings up a prompt to save your work as a file with a different name.

To save a project:
1. Click the ‘I want to…’ option.
2. Click ‘Save’ or ‘Save As’.
3. If you click ‘Save As’ (or if you have not previously
saved the project), the ’Save Project’ screen will open in
the information panel.
4. Give the project a ‘Name’ and ‘Description’.
5. Click ‘Save’.

3.2. Open a Saved Project
To open a saved project:
1. Click the ‘I want to…’ option.
2. Click ‘Open’.
3. Select the project you wish to
open.
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You can sort the projects shown in the Projects window by using any of the following options:




‘Filter Projects…’ allows you to enter text that can be used to filter by the project results.
This will filter results in both the project name and project description.
‘Show my projects only’ will only display projects that you have created.
‘Sort By…’ allows the user to sort the results by project name, date created, date modified,
user modified, or user created.
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4. Home Tab
The ‘Home’ tab contains many of the most commonly use tools in iMapBC.

4.1. Home Tool
The ‘Home’ tool opens the Home screen information in the ‘Information Panel’. The home
screen panel contains quick links to commonly used tools in iMapBC as well a link that users
can use to learn more about iMapBC by accessing the Geographic Data & Services webpage.

4.2. Navigation Tools
The Navigation tools allow the user to move around the map window. This includes the following tools:
Click a location on the map and drag it to another location on the map with the ‘Pan’ tool.

The ‘Zoom In’ tool can be used two ways:
1.
Point Click the map once to zoom in to half of the current scale.
 Hold the mouse button down and draw a box.
2.




You can also zoom in at any time by:
Rolling your mouse wheel forward
Pressing the + (plus) key on the keyboard
Using the zoom slider

The ‘Zoom Out’ tool can be used two ways:
1. Point Click the map once to zoom out to twice the current scale.
 Hold the mouse button down and draw a box.
2. You can also zoom out at any time by:
 Rolling your mouse wheel backward
 Pressing the – (minus) key on the keyboard
 Using the zoom slider

The ‘Full Extent’ tool zooms to the extent of the province of B.C.
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The ‘Back’ tool zooms to the previous map extent.
The ‘Forward’ tool zooms to the next map extent. This tool will appear grayed out until you
have used the ‘Back’ tool.

4.3. Find Data
The only function in the Find Data section of the Home tab is the point ‘Identify’ tool.
This tool allows the user to return additional information about features clicked in the
map window. This tool is described fully below in the Identify Tools section.

4.4. Export
The only function in the Export section of the Home tab is the ‘Print’ tool. This tool allows
the user to create a printable version of their iMapBC session. This tool is described fully
below in the Print tool section.

4.5. Zoom To Tools
The ‘Zoom To’ tool grouping contains tools that can be used to move to specific map locations, based on
exact coordinates or district lots.

4.5.1. Zoom to Coordinate Tools
Albers tool

Lat/Long tool

UTM tool

The three zoom to coordinate tools above follow the
same usage pattern (UTM is shown here as an
example):
1. Click the desired coordinates tool.
2. In the ‘Information Panel’, enter the coordinates
you would like to zoom to.
3. Click the ‘Go to Coordinates’ button.
Note that you also need to enter the UTM zone for the ‘UTM’ tool.
This pull-down menu allows you to select the width of the map you would like to zoom to.
The distances zoomed to from the ‘Extent width’ pull-down menu are approximate.
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4.5.2. Zoom to District Lot Tool
The zoom to ‘District Lot’ tool allows the user to zoom to a specified district lot using
various legal parcel information input methods.

If the Land Districts – Tantalis and Land Act Survey Parcels - Tantalis layer has not
previously added before clicking the zoom to ‘District Lot’ tool, it will be added
automatically to your map layers list and map window.

Users can search for a District Lot using 4 different
options: ‘PIN Number’, ‘Section Township Range’,
‘District Lot’, or ‘Search All’.
The results can be filtered by Land District by
checking the ‘Filter results by land district’ option
and then selecting a Land District.
Enter a ‘PIN Number’ (i.e. 3916200)
- Or –
Enter a ‘Section, Township, and Range’
(i.e. Section 3, Township 28)
- Or –
Enter a ‘District Lot’ (i.e. 1605)
- Or Enter any of the Legal Description to in the ‘Search
All’ field (i.e. 1605, SDYD)
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4.6. Coordinates
The ’Plot Coordinates’ tool allows the user to create coordinates that will be added to the map window.
The user can plot coordinates using two methods:
1. Generate Coordinates in the Map Window (see the Generate Coordinates in the Map
Window section)
2. Manually Enter Coordinates (see the Manually Entering Coordinates section)

4.6.1. Generate Coordinates in the Map window
Click the ’Plot Coordinates’ tool and click any location on the map. A callout will be placed at that
location using the defined coordinate system of the map.
 You can click the map repeatedly to place additional coordinate callouts.

To change the Coordinate System for the callouts, select a Coordinate System from the dropdown menu.

4.6.2. Manually Entering Coordinates
The user also has the option to manually enter coordinates to create a callout in iMapBC.
1. In the Plot Coordinates window click in an empty
coordinates text box.
2. Enter your known coordinates (including North and
West).
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3. Click ‘Add’. The coordinate callout will be added to the map.

To change the Coordinate System for the callouts, select a Coordinate System from the dropdown menu and make any required changes.

4.6.3. Managing Coordinate Callouts
Coordinate callouts can be managed using several different tools outlined in the sections below.

4.6.3.1.

Managing All Coordinate Callouts

The user can click the ‘Menu’ option in the Plot Coordinates window to modify all Plot Coordinates.

Hide All Coordinates
 In the Plot Coordinates window, click the Menu option
and select ‘Hide All Coordinates’.

Delete All Coordinates
 In the Plot Coordinates window, click the Menu option
and select ‘Delete All Coordinates’.
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4.6.3.2.

Managing Individual Coordinate Callouts

The user can click the ‘…’ option to the right of a coordinate to manage that individual coordinate.

Hide Individual Coordinate
 In the Coordinate Actions screen, click
‘Hide Coordinate’ to hide the individual
coordinate callout.
Edit
 In the Coordinate Actions screen, click
‘Edit’ to select the coordinate callout. In
the map window click the location to
which you want the callout to move
Delete
 In the Coordinate Actions screen, click ‘Delete’ to remove the coordinate callout from the
Plot Coordinates list.

4.7. Bookmarks
The ‘Bookmark‘ tool lets you save a particular geographic area that you plan to return
to later in the same iMapBC project.
To open an existing bookmark:
1. Click the ‘Bookmark’ tool.
2. Click the existing bookmark you want to open.
To create a new bookmark:
1. Click the ‘Bookmark’ tool.
2. Click the Bookmark Current Extent button.
3. Enter a name for the bookmark, and then click the
‘OK‘ button.
4. The bookmark will then appear in Bookmarked
Locations list and enable you to return to this same
geographic location.
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5. Data Sources Tab
The tools available under the ‘Data Sources‘ tab provide the ability to add layers from the B.C.
Geographic Data Warehouse (BCGW), as well as upload your own spatial and coordinate data using
external files
When adding and viewing layers, it’s important to understand several map concepts and tool options,
including scale, layer scale dependencies, and layer order.

5.1. Map Scale
When you zoom in, the scale of the map increases - it gets larger. A large-scale map covers a smaller
land area than a small-scale map. A map that is zoomed in to a small town is large-scale, while a map of
British Columbia is small scale.
Small Scale Map Example

A small-scale map shows more
area with less detail

Large Scale Map Example

A large-scale map shows less area,
but more detail

Explanation: Scale is a ratio; 1:10 means that one unit on the map represents ten units in the real world,
or, in this case, the map is one-tenth the size of the real world area it represents. Since scale is a ratio, it
does not matter if the units are centimeters, miles, etc. If you have a 1:100,000 map, the map is
1/100,000 the size of the actual place. 1/100,000 is a much smaller fraction, or ratio, than a scale of
1:10.
The map's scale is located in the status bar below the map window. The scale automatically adjusts as
you zoom in and out on the map.
The Scale Bar can be adjusted manually by typing in a new scale or selecting one of the pre-populated
scales in the list of options.

Scale varies according to monitor, resolution, and size of the browser window. For example, full extent
scale might be approximately 1:12,000,000 on one monitor and 1:7,600,000 on another.
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5.2. Layers Scale Dependencies
Scale dependencies are configured so that individual layers' visibility turns on and off at specific scales.
The layer symbology can also have specific scale dependencies, or renders. For example, a city might be
represented by a tiny polygon that looks like a dot on a small-scale, but on a larger-scale, the entire city
boundary may have an outline and fill colour.
When a layer is unavailable at the current scale, its name
will be grayed out.

When a layer is visible at the current scale, its name will be
black.

To zoom to a scale where the layer is
visible, click the arrow to the right of the
layer name.

In the layer detail options select
‘Zoom to visible scale‘.

Clicking the ‘Zoom to Visible Scale‘ option may not zoom to a particular extent where features
from the layer are located. You may need to pan around the map to find the visible features.

5.3. My Layers
The ‘My Layers’ tool opens the layer list for
iMapBC. All layers that have been added to the
iMapBC session are displayed.
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5.4. Add Provincial Layers
The ‘Add Provincial Layers‘ tool provides access to layers from the B.C. Geographic Data Warehouse
(BCGW). The BCGW is a huge database with roughly 2000 unique layers containing every type of spatial
information used by the B.C. government.
The great majority of these 2000 layers will be accessible to all IDIR account users, with the exception of
select layers with special security groups applied, such as sensitive wildlife occurrence areas and
archaeological sites. If you do not have access to these special layers, they will not be displayed in the
‘Add Provincial Layers‘ tool in the Add/Remove Map Information window but you can search for these
secure layers metadata in the BC Data Catalogue.
The BCGW layers are mainly provincial in scope, but there are subsets of layers named with the ‘L_’
prefix that are specific to particular areas of the Province sometimes referred to as ‘Local’ or ‘Regional’
layers. In these cases, the layer will include the specific geographic area it applies to in the file name,
such as the Telkwa-Skeena area in the example below:

To use the ‘Add Provincial Layers‘ tool:
1. Click the ‘Add Provincial Layers‘ tool from the ‘Data Sources‘ tab and the Add/Remove
Map Information window will open.
2. Find the layer you are looking for by browsing for the layer or entering text in the Search Box.

To remove a filter term
from layer filter, click the
‘X‘.
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3. Click the box next each layer to be added. A check mark will be placed in the box when it is clicked.
Click OK to add the layers to the iMapBC layer list.
Most layers will have a colour-filled version of the layer and an outlined version of the same
layer for visual presentation purposes. Depending on your preference, either version or both
may be added to the map.

5.5. Working with Layers
Once layers have been added to the iMapBC ‘Layers’ list in the information panel, the way they are
displayed in the map window can be changed in many different ways listed below.

5.5.1. Turn layers on and off
Once a layer has been added to the map, it can be
turned off by clicking on the box to the left of the layer
in the ‘Layers’ list. The check mark will then be
removed, and the layer will no longer be visible in the
map window.

5.5.2. Zoom to full extent
Once a layer has been added to the map, you can zoom to the
full extent of the dataset by clicking the arrow to the right of the
layer name to open the layer options and selecting the ‘Zoom to
full extent’ option.
The layer may not be visible if you select this option
based on the layer visibility scale.

5.5.3. Zoom to visible scale
You can zoom to the visible scale of the layer, the scale
where the layer will be visible by clicking the arrow to the
right of the layer name to open the layer options and
selecting the ‘Zoom to visible scale’ option.
There may be no features in the map window for
the visible extent. If this is the case, pan around the
map window to see the layer features.

5.5.4. Remove a layer
To remove a layer, click the arrow to the right of the layer
name to open the layer options and select ‘Remove Layer'.
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5.5.5. Layer Visualizations
The visualization of any layer in the map can be changed from its
default visualization by clicking the ‘Turn on/off layer visualizations’
option. Layers can be made up of points, lines, or a polygon. They all
follow the same basic pattern for changing their visualization, but the
characteristics that can be changed for each of the three vary by
geometry type.
To change the visualization for a layer click the arrow to the right of the
layer name to open the layer options and select the ‘Turn on/off layer
visualizations’ option.
When the ‘Select a visualization for your layer:’ option opens, there are
two choices available:
1. None: This will return the layer to the default layer
symbolizations.
2. Custom Layer Style…: This will allow you to make your own custom visualizations for a layer.

When the ‘Custom Layer Style…’ option is selected, the Visualizations Option screen shows all of the
methods to change the layer visualizations.





Choose Symbology Type: There are two options:
o The ‘Simple‘ Symbolization Type makes each feature
in the layer appear the same way visually.
o The ‘Attribute’ option will allow you to define a
visualization based on the attribute field. This is
described fully in the Visualizations by Attribute
section below.
Change the ‘Color’ of the layer visualization.
The ‘Transparency’ option allows you to adjust the
percentage of transparency of the feature. The lower the
percentage, the more transparent (or less visible) the
feature will be.
19







‘Marker Size‘ (point layers only) allows you to change the size of the point feature symbol.
‘Line Width’ is the thickness of the outline surrounding the feature.
‘Line Style’ allows you to change the outline style (dots, dashes, etc.).
‘Fill Style’ allows you to change the fill style (solid fill, cross-hatching, etc.).
‘Marker Style’ (point layers only) allows you to change the shape of the marker symbol.

Once the visualization has been customized:
 Click ‘Apply’ to make the visualization changes in the map window, but keep the Visualization
Options screen open.
 Click ‘Done’ to make the visualization changes in the map window, and close the Visualization
Options screen.

See Exercise 2 (in Appendix A): Change Point Symbology for an
example of this function.
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5.5.5.1.

Visualization by Attribute – Unique Values

The Unique Values visualization option symbolizes groups of features that have matching attributes,
(i.e. school types, soil types, classifications, etc.). If there are
more than 12 different unique values for an attribute, only
the first 12 will be used.
The following options are available for Unique Values
visualization:
 ‘Choose Symbology Type’ needs to be set to the
‘Attribute’ option to create Unique Values.
 ‘Pick an attribute to symbolize’ (where you wish to
generate unique values from).
 The ‘Transparency’ option allows you to adjust the
percentage of transparency of the feature.
 ‘Marker Size‘(point layers only) allows you to change the
size of the point feature symbol.
 ‘Line Width’ is the thickness of the outline surrounding
the feature.
 ‘Marker Style’ (point layers only) allows you to change
the shape of the marker symbol.
Note: The symbology for each individual feature can be
symbolized separately.
 The ‘Transparency’ option allows you to adjust the
percentage of transparency of the feature.
 ‘Marker Size‘ (point layers only) allows you to change the
size of the point feature symbol.
 ‘Line Width’ is the thickness of the outline surrounding
the feature.
 ‘Marker Style’ (point layers only) allows you to change
the shape of the marker symbol.
Once the visualization has been customized:
1. Click ‘Apply’ to make the visualization changes in the
map window, but keep the Visualization Options
screen open.
2. Click ‘Done’ to make the visualization changes in the
map window, and close the Visualization Options
screen.
See Exercise 3 (in Appendix A): Symbolize by Attribute for an
example of this function.
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5.5.5.2.

Symbolize by Attribute –Class Breaks

The Class Breaks Symbolization type makes each feature in a layer appear differently based on a specific
numeric attribute in the layer. In order for this type of symbolization to work, the attribute must be
numeric.
An example of a numeric attribute in a layer would be the age of trees in a vegetation layer. The
vegetation layer has an attribute (column) named ‘Projected Age,’ and numeric values in the column
would contain the age of the tree stands in years such as 10, 20, 30, 40, 50, 60, 80, and 100. The Class
Breaks Symbolization type allows you to display stands of
trees in each of those age classifications differently.
The following options are available for Unique Values
visualization:
 ‘Choose Symbology Type’ needs to be set to the
‘Attribute’ option to create Unique Values.
 ‘Pick an attribute to symbolize’ (where you wish to
generate unique values from). This will need to be a
numeric field.
 The ‘Number of Classes’ allows you to set how many
class breaks you want displayed.
 The ‘Start Color’ sets the start colour of your class
breaks colour scale.
 The ‘End Color’ sets the end colour of your class
breaks colour scale.
 The ‘Transparency’ option allows you to adjust the
percentage of transparency of the feature.
 ‘Line Width’ is the thickness of the outline surrounding
the feature.
The symbology for each individual feature can be
symbolized separately.





The ‘Transparency’ option allows you to adjust the
percentage of transparency of the feature.
‘Line Width’ is the thickness of the outline surrounding
the feature.
‘Line Style’ allows you to change the outline style (dots,
dashes, etc).
‘Fill Style’ allows you to change the fill style (solid fill,
cross-hatching, etc.)
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Once the visualization has been customized:
 Click ‘Apply’ to make the visualization changes in the map window, but keep the Visualization
Options screen open.
 Click ‘Done’ to make the visualization changes appear in the map window, and close the
Visualization Options screen.

5.5.6. Toggle Labels
If your layer contains labels, the labels can be toggled on or off by
clicking the arrow to the right of the layer name to open the layer
options and selecting the ‘Toggle labels’ function.
If no labels have been configured for the layer, this can
be done using the Customize Labels function.

5.5.7. Customize Labels
You can create custom labels or change existing labels for a layer by
clicking the arrow to the right of the layer name to open the layer
options and selecting the ‘Customize labels’ function.
Once selected the customize label screen will open. The user will be able
to select:
1. To turn the label visibility on/off by clicking the ‘Show Labels’
option.
2. Select the layer attribute ‘Field’ that will be used to generate the
labels.
3. Set the label ‘Font Size’.
4. Set the label ‘Font Color’.
Once the label has been customized:
 Click ‘Apply’ to make the label changes in the map window, but keep the customize label screen
open.
 Click ‘Done’ to make the label changes in the map window, and close the customize label
screen.
 If there were preset labels for the layer, the user can click ‘Reset to Default’ to return to the
layer’s default labels.
 Click ‘Cancel’ to ignore any changes and close the customize label screen.
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5.5.8. Metadata URL
Metadata is often described as 'information about information' or 'data about data'. The DataBC
geographic metadata service is called the BC Data Catalogue (or BCDC). The BC Data Catalogue pages
explain data uses, limitations, currency, update cycle, and distribution. The Freedom of Information and
Protection of Privacy Act includes precise guidelines on the distribution of government information.
BC Data Catalogue metadata records are available for all of the layers added from the ‘Add Provincial
Layers‘ tool (BCGW layers).
To access the BC Data Catalogue metadata record for particular layer,
click the arrow to the right of the layer name in the ‘Layers’ list to
open the layer options and select ‘Metadata URL’.

A new browser window will open and the layer's metadata record will be displayed.
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5.6. Upload Data Tool
The ‘Upload Data’ tool allows you to upload spatial or coordinate information from your
computer into iMapBC so it can be viewed.
The following data formats are acceptable to use as an input data layers when using the ‘Upload Data’
tool:
 .csv – comma separated values containing coordinates saved in a table
 .xlsx – Microsoft Excel table containing coordinates saved in a table
 .kml – Google earth files
 .shp – ESRI shapefiles
o Note: if selecting a shapefile, all required components of a shapefile must be selected
(.shp, .dbf, .prj)
 .gpx – GPS Exchange Format, is a common GPS data format for waypoints or coordinates
 .zip – Compressed file that contains either a shapefile or File Geodatabase
To use the ‘Upload Data’ tool:
1. Click the ‘Data Sources’ tab and click the ‘Upload
Data’ tool.
2. In the ‘Add Data to Map’ window, click ‘Browse…’
3. Navigate to where your data is saved.
4. Click ‘Open’.
5. Click ‘Upload’ to add the layer to the map window.
It is important to select all associated files of your upload data set. If you are uploading a
shapefile, you need to select all of the associated files, or the layer will not be added to iMapBC
correctly.
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6. Export Tab
The ‘Export’ tab provides users with different methods for getting the information from iMapBC to
other platforms, using printed maps, images, or by downloading the data.

6.1. Print
The ‘Print’ tool allows the user to create a map that can be saved, and later sent to a printer,
copied to a document, or emailed to other people.
A variety of printing templates have been developed by various business areas for use in iMapBC. In
these printing templates, map titles and data entry boxes for business-specific content are available to
customize the templates for use.
To print a map:

Select your print
layout here.

1. Click the ‘Print’ button on the ‘Export’ tab.
2. Select the preferred printing options:
 Output Format: Set the map output format.
This can be PDF, TIFF, BMP, GIF, JPEG, or BMP.
 Resolution: Set to either High or Low
resolution.
 Grid: Adds the Latitude / Longitude
 Map Scale: Set the map scale of the output
map. This can be a specific set scale, the
current extent (what is seen in the current
map), or the current map scale.
If you change the scale or use current
extent you may cause layers in output
to not display due to the visible layer
extent of those layers.


Title: Give the map output a title.

3. Click the ‘Print’ button.
4. In the Create Printable Map screen, click the ‘Open
File’ button to view the map output.
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6.2. GeoTiff URL
The ‘GeoTIFF URL’ tool creates a URL link that allows you to share the map as a GeoTIFF
image with other users.
This is the tool to get data into Avenza Map.
A GeoTIFF image provides georeferencing information embedded in a TIFF image file. You can
view this image along with other sources of georeferenced map data in any third-party
software that supports this public domain standard.
To use the ‘GeoTIFF URL’ tool:
1. Click the ‘GeoTIFF URL’ tool on the ‘Export’ tab.
2. The GeoTIFF will be created. You can copy and paste
the URL from the text box to share with other users.

6.3. Export Image
The ‘Export Image’ tool produces images of the Map Window in PNG, BMP, JPEG, TIFF, GeoTIFF, and
PDF formats. An option is available to export the images, including georeferenced data that can be used
to import the images into a GIS platform.
To use the ‘Export Image’ tool:
1. Click the ‘Export Image’ tool on the ‘Export’ tab.
2. In the first ‘Export a Map Image’ box, select the image
format and check the box if you would like the file to
include georeferencing information. Then click the ‘Create
Image’ button.

3. In the second ‘Export a Map Image’ box, click the ‘View
Image’ button.
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4. The image file will be placed in a zip file which you can then open or save to an appropriate location.

The zip file contains the image file (.TIF),
as well as two files created for image
georeferencing purposes.

6.4. Save Markup as Shapefile
The ‘Save Markups as Shapefile’ tool exports any markups you have created using the
‘Draw’ tools as a shapefile. Markups can be drawings created from the ‘Sketch’ tab,
measurement drawings, or buffered identify drawings.

The shapefiles created will be exported in the Web Mercator projection. A shapefile is a very common
format for GIS staff to use in third party applications.
To use the ‘Save Markups as Shapefile’:
1. Create your markup.
2. Click the ‘Save Markups as Shapefile’ tool on the ‘Export’
tab.
3. In the ‘Download “.shp” file’ box click the ‘OK’ button.

4. Depending on your internet browser, the download dialog box will open. Click ‘Open’ to view
the download contents.
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5. A zip file will open containing your shape file. You can email the zip file to a GIS user or extract
the shape file to a location on your network.

A shapefile will have at a minimum of 3 files associated with it (.dbf, .shp, .shx). All three of
the files are required to be present to view the shapefile in a GIS viewer in addition most
viewers also require the .prj file in order to determine the projection of the features.
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6.5. Provincial Layer Download
The ‘Provincial Layer Download’ tool allows you to extract layers from iMapBC to use in
third party applications.
You can customize the extent of the data, the data clipping method, and the output format.
To use the ‘Provincial Layer Download’ tool:
1. Add the layers you wish to download to your iMapBC session using the ‘Add
Provincial Layers’ tool from the ‘Data Sources’ tab.
2. Click the ‘Provincial Layer Download’ tool on the ‘Export’ tab.
3. In the ‘Data Download Service’ screen, set the following options:
a. The data download extent can be set to ‘Map
Extent’ (download features in the current map
extent) or ‘Full Dataset’ (all features in the
dataset).
b. The ‘Data Clipping Method’ option is only
available if the download extent is set to ‘Map
Extent’.
 You can select the ‘Intersect’ option that will
select the complete features that are within the
map extent.
 You can select the ‘Clip’ option that will cut
features to the map extent.
c. Toggle the layers in the layer list that are to be
downloaded.
 You can also use the ‘Select All’ option to
toggle all layers on or the ‘Clear All’ option to
toggle all layers off.
d. Once complete, click ‘Prepare Order…’.
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4. The ‘Current Order’ window will open. Set the following options:

a. ‘Coordinate System’ will set the downloaded datasets
coordinate system.

b. ‘Format’ will allow you to select your download output format.

c. ‘Area of Interest’ option allows you further choices to
define your data download selection extent.
 ‘No Area of Interest Applied’ will not apply any
further area of interest to your download extent.
 ‘Draw a Custom AOI’ allows you to select a .zip file
containing a shapefile or open a map window to draw a shape as your custom AOI extent.
This is further explained in the section below.
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 ‘Map Extent/Bounding Box’ is set by default if in the previous screen the ‘Map Extent’
option was used.
 ‘Geomark’ allows you to use an existing geomark shape as your AOI. You can select the
clip method (‘Clip’ or ‘Intersect’), ‘Enter a Geomark’ URL, and click ‘Use Geomark’.

 ‘Mapsheet’ allows you enter a map sheet (or multiple map sheets separated using a
comma) as your AOI.
Set the clip method (‘Clip’ or ‘Intersect’), ‘Enter a Mapsheet’, and click ‘Use Mapsheet’.

d. ‘Included Layers’ shows the layers that are included in the current download order.
 The ‘% of Max:’ field shows the total size of the current order. This cannot exceed 100%
or you will not be able to process your download order.
If the ‘% of Max:’ exceeds 100%, you will need to remove layers or set an area of
interest to reduce the size to below 100%

 Layers can be removed from the current order by clicking the ‘X’ option.
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5. Enter your email address and agree to the Terms and Conditions.

6. Click ‘Submit Order’.
7. Your downloaded data will be sent to your email. You will receive two emails:
a. The order submission email will notify you that your order has been submitted.

b. The order assembly email will contain your order details and URL to the data package.

In the email, click the URL link to access the data.
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6.5.1. Create Custom AOI Options
This section further explains the ‘Draw a Custom AOI’ option from the ‘Area of Interest’ selection in the
Current Order window.
There are two Custom AOI options:
1. ‘Draw a Custom AOI’
2. ‘Select a .zip file containing a shapefile‘

6.5.1.1.

Draw a Custom AOI

Click the ‘Draw a Custom AOI’ tool to open the AOI Selector map window.
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The functions in the map window work the same as the functions in iMapBC window. These options
include:
 Search options
 Zoom tools
 Base map options
 Scale options
 Right–click options
To draw a custom AOI:
1. Zoom to the location in the map window where the AOI is to be drawn.

2. In the ‘Select Area of Interest’ screen, click the geometry option to be drawn (Point, Line,
Polygon).
3. In the map window, draw your AOI geometry. If drawing a polygon, click to add each vertex and
double click to complete the geometry.
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4. Once the geometry has been drawn, the ‘Select Area
of Interest’ screen will state: ‘Geometry captured’.

5. Click ‘Next’.

6. The ‘Select Area of Interest’ screen will provide the following options:
 ‘Remove Polygon’: Removes the polygon as
an AOI. If there is only one shape in the map
window the shape will be removed. If there
is more than one AOI shape, you will be
prompted to select which AOI is to be
removed.
 ‘Add More Polygons’: Allows you to create
another shape to use as an AOI.
 ‘Submit AOI’: Will close the AOI Selector window and set the shapes as the AOI.

6.5.1.2.

Select a .zip File That Contains a Shapefile

You can also use a shapefile that is stored in a .zip file to use as a Custom AOI.

To use a .zip file as the custom AOI:
1. Set the Area of Interest to ‘Draw a Custom AOI’ and click ‘Browse…’.
2. Zoom to the location where the zip file is created and click ‘Open’.
See Exercise 4 (in Appendix A): Provincial Layer Download for an
example of this function.
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7. Sketch Tab
The iMapBC ‘Sketch’ tab provides tools to draw your own material on the map. These tools are useful
for many reasons, including marking corrections to a data layer and submitting them to your local data
custodian.

7.1. Draw Tools
The following nine basic Draw tools all follow the same pattern of use:

The ‘Polygon’ tool will be used as the example of the 9 basic drawing tools workflow.
1. Click the ‘Polygon’ drawing tool under the ‘Sketch’ tab.
2. When you select the ‘Polygon’ tool, you activate the ‘Enable Snapping’ and ‘Style’ tools. The ‘Style’
tool can be used to set the symbology of the polygon you are drawing.

Select the Style for
the polygon

3. Click the first point on the map, and the first point of the polygon will be drawn there.
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4. Continue clicking points around the polygon until the desired shape is complete, and then double
click to finish the polygon.

All 9 of the basic draw tools are described in this table:
Tool
Action
Click ‘Point’, and then click any point on the map.
Click ‘Text’, and then click any point on the map.
Type the text you want to add at this location on the map and click ‘OK’.
Click ‘Line’, and then drag across the map to draw a line.
To continue the line but change direction, click and then drag in the new direction.
To end the line, double-click.
Click ‘Freehand’, and then draw in any direction on the map to create a line
drawing.
Click ‘Freehand Shape’, and then drag across the map.
An arrow forms under your cursor. To change the shape and size of the arrow, drag
it up, down or sideways.
Click ‘Ellipse’, and then drag across the map to draw an ellipse.
The ellipse draws from the corner of the shape, so you can change the shape by
moving the cursor up and down or sideways.
Click ‘Circle’, and then drag away from that point to draw the shape.
The circle draws from the center out, so the further you drag your cursor, the bigger
the circle will get.
Click ‘Polygon’, and then drag across the map to start a polygon.
To change direction, click and then drag in a new direction. Shading appears to
indicate that the polygon is filling in the space of the area made by your drawing.
Double-click to end the polygon.
Click ‘Rectangle’, and then click one corner of the rectangle you want to draw. Drag
away from that corner and a shaded rectangle will form under your cursor.
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7.1.1. Enable Snapping
When drawing markup, you can snap your vertices (points) to existing markups on the
map. Snapping is useful as it makes it easier to draw precisely to the exact point on the
mark up.
To use, click the ‘Enable Snapping’ option and then select any of the ‘Sketch’ tools.
A circle around the mouse cursor appears and the vertex (white square) will snap to the existing markup
edge.

To disable snapping, click the

tool.

Only drawn features can be used for snapping. BCGW layers are not enabled for snapping.

7.1.2. Select Snapping Layers
**Layers are currently not enabled for snapping in iMapBC.

7.1.3. Edit tool
The ‘Edit’ tool is used to move, edit, or restyle the geometry of a drawing in the map
window.
To edit a drawing:
1. Click the ‘Edit’ tool.
2. Click the drawing to be edited. Each vertex in the shape will be displayed as a dark grey circle.

39

3. The following edits can now be made:
Edit
Move Vertex

Process
Left-click and drag a vertex to its
preferred location. Release the
button to finalize the location of a
vertex.

Add Vertex

Click on one of the white circles
between the vertices (larger grey
circles).

Delete Vertex

Right click on a vertex (grey circle).
The Delete option will appear. Click
‘Delete’ to remove the vertex.

Resize Drawing

Left-click and drag one of the white
squares around the drawing to
resize the drawing.

Move Drawing

Left-click and drag in the center of
the drawing to move the shape to a
new location.

Rotate Drawing

Left click and drag the white square
at the top centre of the drawing to
rotate the drawing.

Image
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Restyle Drawing

On the Sketch toolbar, click the
‘Styles’ tool and select your style
preference.

4. When you are finished editing, left-click outside of the shape to complete edits to your sketch.

7.2. Grid Display Tools
The ‘Add a Grid’ tool adds a grid to your current map extent. The grid added does not
follow any particular lines of latitude or longitude.
To add grid:
1. Select the ‘Add a Grid’ from the Sketch tab.
2. In the ‘Enter Number of Columns and Rows’ screen, select the preferred options and click ‘OK’.

3. The map will be divided into the defined grid pattern.

To remove a ‘grid’, click the ‘Clear Grid’ tool from the ‘Sketch’ tab.
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7.3. Measure Tools
The measure ‘Distance’ and measure ‘Area’ tools are simple tools for drawing features and measuring
distance and area.

7.3.1. Measure Distance
The measure ‘Distance’ tool is convenient for measuring linear paths on the map.
To use the measure ‘Distance’ tool:
1. Click the measure ‘Distance’ tool.
2. After you click the start point for the line feature to measure and move your mouse away, if you
stop in a location, a black label will appear showing how far the mouse location is away from the
previous point.

3. Continue clicking points until your line feature is complete. Each segment will be labeled with
its length, and the total distance will be shown in black at the end of the line feature.
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4. The user can change the units of display during or after creating the distance measurement. Set
the units for the ‘Distance’ and ‘Area’.

5. To remove the measured line shown on the map, click the ‘Clear’ tool
Drawings section) when you are finished.

(in the Edit

7.3.2. Measure Area
The measure ‘Area’ tool is convenient for measuring linear paths on the map.
To use the measure ‘Area’ tool:
1. Click the measure ‘Area’ tool

.

2. After you click the start point for the polygon feature to measure and move your mouse away, if
you stop in a location, a black label will appear showing how far the mouse location is away
from the first point.

3. Continue clicking points until your polygon feature is completed. Each segment will be labeled
with its length, and the total perimeter, and area will be shown in black in the centre of the
measured area.
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4. The user can change the units of display during or after creating the distance measurement. Set
the units for the ‘Distance’ and ‘Area’.

5. To remove the measured line shown on the map, click the ‘Clear’ tool
Drawings section) when you are finished.

(in the Edit

7.3.3. Snapping Tools
When drawing markup, you can snap your vertices (points), to existing markups or
measurements on the map. Snapping is useful because it makes it easier to draw
precisely to the exact point on the mark up.
To use, click the ‘Enable Snapping’ option and then select either of the ‘Measure’ tools.
A circle around the mouse cursor appears and the vertex (white square) will snap to the existing markup
edge.

To disable snapping, click the

tool.

Only drawn features can be used for snapping. BCGW layers are not enabled for snapping in
the BCGW.

7.3.4. Select Snapping Layers
**Layers are currently not enabled for snapping in iMapBC.
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8. Find
The ‘Find’ tab contains a variety of tools designed to search and analyze information.

8.1. Identify tools
The ‘Point, Freehand, Line, Polygon, and Rectangle Identify’ tools are used to search the layers of the
map to determine a listing of features that fall within the area identified and provide additional
information on specific features. Use this tool when you know where you wish to look but don’t know
which loaded layers have information for that location.

All of the ‘Identify’ tools follow the same basic workflow. The ‘Polygon Identify’ tool is used in the
example below, but each of the ‘Identify’ tools is described in the table at the end of this section.
To use the ‘Polygon’ identify tool:
1.

On the ‘Find’ tab, click the ‘Polygon’ identify tool.

2. Click on the map to start drawing the feature.

3. When the final point of the polygon is ready to
be placed, double click on the map to finalize
the shape. The polygon will then disappear
from the map, and the results will be displayed
in the ‘Identify Results’ window in the
‘Information Panel’.
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The ‘Identify Tool’ Actions:
Tool

Actions
Click ‘Point’ identify and then click any point on the map. Any features found at that
point on the map are included in the identify process.
Click ‘Freehand’ identify and then draw in any direction on the map over the features
that you want to include in the identify process. When you lift your finger from the
mouse, the identify process begins. All the features that intersect with the line are
included in the identify process.
Click ‘Line’ identify and then drag across the map to draw a line.
To continue the line but change direction, click the map and then drag in the new
direction. To end the line, double-click. All the features that intersect with the line
are included in the identify process.
Click ‘Polygon’ identify and then drag across the map to start a polygon.
To change direction, click and drag in a new direction. A black shading appears under
your cursor to indicate that the polygon is filling in the space of the area.
Continue to click until the shading has covered the area you want to include in the
identify process. Double click to end the polygon. You do not have to complete the
shape. As long as the shading covers the area, you can double-click and the line will
be completed automatically. All the features beneath the shaded area are included in
the identify process.
Click ‘Rectangle’ identify and then click on one corner of the area you want to define.
Drag a square away from the corner you clicked. A black shaded square appears
under the cursor. When your area is enclosed in the square, lift your finger from the
mouse. All the features covered by the rectangle are included in the identify process.

Scale dependencies still apply. If the layer name is greyed out it is not visible and therefore not
included in the results.
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8.1.1. Enable Buffering
The ‘Enable buffering’ identify option allows a buffer distance to be applied around the
‘Identify’ tool drawing.
After drawing the ‘Identify’ tool search area, select the ‘Buffered Shape’ option to display the ‘Buffer
Options’ box. Select the buffer distance, units of measure, and whether the buffer is to be added to the
resulting ‘Identify’ tool markup.

When the final point of the polygon is ready to
be placed, double click on the map to finalize
the shape. The polygon will then disappear
from the map, and the results will be displayed
in the ‘Identify Results’ window in the
‘Information Panel’.
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8.1.2. Enable Snapping
When drawing an identify shape, you can snap your vertices (points) to existing markups
on the map. Snapping is useful as it makes it easier to follow precisely to the exact
verities on the mark up.
To use, click the ‘Enable Snapping’ option and then select any of the ‘Identify’ tools.
A circle around the mouse cursor appears and the vertex (white square) will snap to the existing markup
edge.

To disable snapping, click the

tool.

Only drawn features can be used for snapping. BCGW layers are not enabled for snapping.

8.1.3. Select Snapping Layers
**Layers are currently not enabled for snapping in iMapBC.

8.1.4. Identifiable Layers
The ‘Identifiable Layers’ option allows you to select which layers the identify tool will
query.
Layers with a check mark will be returned in search layers in the search ‘Identify Results’ window.
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8.2. Working with Results
The ‘Identify’ tool, ‘Search Box’, and the ‘Query Tools’, all produce search results that are placed in the
‘Search Results’ window. The ‘Results’ window includes a multitude of options. These options alter the
layers searched and the way information is reported and displayed.

8.2.1. Results Overview
Each feature within the area
searched will be included in
the ‘Results List’.

Features listed in the ‘Results
List’ are grouped by layer.

Click the ‘Results List Menu’ for additional options to show feature details, buffer features, or save,
open, or combine your results.

‘Switch to Table’ allows the results to
be displayed in a table view format.

‘Show Buffer Options’ allows the
feature to be used to then ‘identify’
other features shown on the map.

‘Open Saved Results’ opens a
previously saved results list.

‘Save Results’ saves the results list
so it can be accessed later.

‘Combine Results’ allows for multiple
saved result lists to be combined.
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Clicking a feature in the ‘Result List’ will zoom the map
to the feature location and open the detailed result
information.

8.2.1.1.

Detailed Result Menu Options

Once you select a result the detailed result information is displayed. Along with displaying the detailed
result information, the ‘Detailed Result Menu’ is available.

‘Show Buffer Options’ allows the
feature to be used to then ‘identify’
other features shown on the map.

‘Zoom to Feature’ zooms the map to
the feature.
‘Pan to Feature’ moves the map to
the feature without changing the map
scale.
.

‘Remove from Results’ removes the
feature from the ‘Results List’.
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8.2.2. List View and Table View
The ‘List View’ and ‘Table View,’ options are two different ways of viewing search results.
List View
The ‘List View’ is the default view for the viewing the ‘Results List’.

Table View
Switch to the Table View option by clicking ‘Results List
Menu’ option and selecting ‘Switch to Table’.

The ‘Table View’ displays the same features as the ‘List View,’ but shows them in tabular format.
Feature are shown in a tabular format
and sorted by layers. Switch to other
layers by clicking the tab along the top of
the ‘Table View’.

Scroll through all of the attributes /
textual information available for the
feature by using the slider at the bottom
of the ‘Table View’.
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In the ‘Table View’, the ‘Table View Menu’ provides several options:
‘Switch to List’ switches the results to list
format.
‘Show Buffer Options’ allows the feature
to be used to then ‘identify’ other
features shown on the map.
‘Export to CSV’ exports the results to a
CSV (comma separated values) file for
external use.
‘Export to XLSX’ exports the results to a
Microsoft Excel file for external use.
‘Open Saved Results’ opens a previously
saved results list.

‘Save Results’ saves the results list
so it can be accessed later.

‘Combine Results’ allows for multiple
saved result lists to be combined.

8.2.3. Open Saved Results
The ‘Open Saved Results’ function allows the user to access, edit, and delete previously saved result
lists.
To view the ‘Saved Results’ screen, click the ‘Results List
Menu’ and select the ‘Open Saved Results’ option.
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In the ‘Saved Results’ screen, the user has the following options:
Click on a previously saved ‘Result List’ to
open the list.

Click the ‘Edit List Name’ tool to
rename the result list.

Click the ‘Delete List’ tool to
remove the result list from the
Saved Results screen.

8.2.4. Save Results
The ‘Save Results’ function allows the user to save a result list to the project.
To save a result list to your project, click the ‘Results List
Menu’ and select the ‘Save Results’ option.
Give the Result List a name and click ‘Save’.

8.2.5. Combine Results
The ‘Combine Results’ function allows the user to use their current result list with a previously saved
result lists to create a new list of results. This can be done by adding, subtracting, or matching
intersecting results between the two lists.
To combine result lists, click the ‘Results List Menu’
and select the ‘Combine Results’ option.
The ‘Combine Results’ screen will open.
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8.2.5.1.

Add to Results

The ‘Add to Results’ function combines a saved set with your current result list.
1. Once you have made your current select, click
the ‘Results List Menu’ and select the
‘Combine Results’ option.
2. The ‘Combine Results’ screen will open. Select
the ‘Add to results’ option.

3. Put a check next to the saved result list you
wish to combine with your current selection.
Click ‘OK’.
4. Your results will be combined.

Current Result List

Saved Result List

Combined Result List

If a feature is selected in multiple result lists, it will only exist once in the final combined
result list.
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8.2.5.2.

Subtract Saved Results

The ‘Subtract saved Results’ function removes results from a saved set from your current result list.
1. Once you have made your current select, click
the ‘Results List Menu’ and select the
‘Combine Results’ option.
2. The ‘Combine Results’ screen will open. Select
the ‘Subtract saved results’ option.

3. Put a check next to the saved result list you
wish to subtract from your current selection.
Click ‘OK’.
4. Your results will be combined.

Current Result List

Saved Result List

Subtracted Final Result List
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8.2.5.3.

Match Intersecting Results

The ‘Match intersecting results’ returns a list of results of only features that match between your
current selection and selected saved result lists.
1. Once you have made your current select, click
the ‘Results List Menu’ and select the
‘Combine Results’ option.
2. The ‘Combine Results’ screen will open. Select
the ‘Match intersecting results’ option.

3. Put a check next to the saved result list you
wish to subtract from your current selection.
Click ‘OK’.
4. Only the features that exist in both lists will be returned to the final intersecting result list.
Current Result List

Saved Result List

Intersecting Result List
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8.3. Feature Location
The ‘Zoom to Feature Location’ tool provides a list of geographic areas that can be zoomed
to through a two-step process:
Step #1: Select the type of geographic area you would like to zoom to and click ‘OK’.

Step #2: A second pick list will be presented with specific features from the layer selected. Select the
specific geographic feature from the specific features pick list and click ‘OK’.
The map will then be zoomed to the selected features location.

This tool does not add the layers to the map window. Use the ‘Add Provincial Layers’ tool to
add the layers to view them in the map window.
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8.4. Search by Query
The ‘Search by Query’ tool makes it possible for you build complex queries without
knowing how to write SQL statements. Results are show in the information panel, just like
the ’Identify’ results.
1. Click the ‘Search by Query’ tool under the ‘Find’ tab.
2. Select the layer you want to query from the ‘Data Source’ drop-down list.

3. Select the attribute from the ‘Field’ drop-down list that you want to include in the first part of your
query statement. For example, select ‘Park Class’.

4. From the ‘Operator’ drop-down list, select the operator. For example, select ‘=’.
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5.

In the ‘Value’ field, type in the value you want to query. For example, type ‘Cla’. As you type, a list
of possible options for this value will become displayed.

Query attribute values are case sensitive. The list of generated attribute values is not. It is
usually best to select an option provided from the drop down list of results to ensure your query
uses the correct attribute value.

6. If you want to make the statement more specific, click ‘Add Another
Condition’ and define another set of parameters.
7. To remove a condition, click the ‘X’ icon.
8. Optionally, a ‘Spatial Filter’ can be added. This allows the user to define if the query will only search
in the map extent or map drawings.

9.

Click the ‘Search’ button.

10. Your query results will be shown in the ‘Query Results’ window.

See Exercise 5 (in Appendix A): Select by Query for an example of
this function.
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8.5. Filter by Layer
The ‘Filter by Query’ tool makes it possible for you build complex queries that will filter
(hide) features from the layer that do not meet the specified criteria.

1. Click the ‘Filter by Query’ tool under the ‘Find’ tab.

2. Select the layer you want to query from the ‘Data Source’ drop-down list.

3. Select the field from the ‘Field’ drop-down list that you want to include in the first part of your
query statement. For example, select ‘Projected Height’.

4. From the ‘Operator’ drop-down list, select the operator. For example, select ‘>’.
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5. In the ‘Value’ field, type in the value you want to query. For example, type ‘20’. As you type, a list of
possible options for this value will become displayed

6. If you want to make the statement more specific, click ‘Add Another
Condition’ and define another set of parameters.
7. To remove a condition, click the ‘X’ icon.
8. Optionally, a ‘Spatial Filter’ can be added. This allows the user to define if the query will only search
in the map extent or map drawings.

9.

Click the ‘Filter’ button.

10. Your filter will be shown in the map window.

The Identify tools will not give results for items affected by a filter.

See Exercise 6 (in Appendix A): Filter by Query for an example of
this function.
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9. Help
Users may require additional information regarding the iMapBC application. Additional help can be
accessed using the option in this section.

9.1. Help Tab Tools
The ‘Help’ tab contains tools that allow the user to get more information regarding iMapBC.

The ‘FAQ’ tool opens the iMapBC Frequently Asked Questions PDF document in a
separate window.
The ‘What’s New’ tool opens the What’s New with iMapBC website in a separate
browser window that lists the recent changes to iMapBC.
The ‘Training Manual’ tool opens the iMapBC training manual in a separate browser
window.

9.2. Questions or Reporting Issues with iMapBC
Issues with iMapBC can be reported to the Natural Resource Sector Business Service Helpdesk:
Hours of Operation: 8:00 a.m. - 4:30 p.m. (PST), Monday to Friday
Phone (within Victoria): 250-952-6801
Toll Free (within BC): 1-866-952-6801
E-Mail: NRSApplications@gov.bc.ca (to open a ticket)
NRSEnquiries@gov.bc.ca (to ask a question)
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Appendix A: Training Exercises
The following section contains the exercises that users can perform to better understand the iMapBC
application.

Exercise 1: Search for an Address
Search for an address in Bella Coola.
1. Type ‘450 MacKenzie St’ in the Search Box.

2. Click the ‘Begin Search’

icon.

3. Notice the results return once search is complete. Click on the result for the address 450 MacKenzie
St, Bella Coola, BC. in the information panel. This will zoom the map to the address and open the
attribute information for the address.

- End of exercise -
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Exercise 2: Change Point Symbology
Change the size and colour of the Major Cities point symbology on the map.
1. On the ‘Data Sources’ tab, click the ‘Add Provincial Layers’ tool.
2. Under Base Maps > Base Map Auto Scale (1:7,5,000,000 – 1:20,000), put a check next to
‘(1:7,500,000) Major Cities’ and click ‘OK’.
3. Click the ‘Layers’ Information Panel Icon.

4. In the Layers list, click the arrow

to the right of the ‘(1:7,500,000) Major Cities’ layer.

5. In the Layer Options screen, select ‘Turn on/off layer Visualization’.
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6. In the Visualization Options screen, change the drop-down to ‘Custom Layer Style…’

7. Select a ‘Color’ option.
8. Set the Transparency to ‘50%’.
9. Change the Marker Size to ‘12 px’.
10. Change the Marker Style to ‘Square’.
11. Click ‘Done’.

The layer visualizations will be updated in the map window.

- End of exercise –
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Exercise 3: Symbolize by Attribute
Symbolize the Schools (K-12) layer by attribute using the education level of each school as a
classification.
1. On the ‘Data Sources’ tab, click the ‘Add Provincial Layers’ tool.
2. Under Education > Schools (K-12), put a check next to 'Schools (K12)' and click 'OK'.
3. Click the ‘Find’ tab and click the ‘Feature Location’ tool.
4. In the Find a Feature Location screen, select ‘Municipality’, click ‘OK’ and then select ‘Nanaimo’. Click
‘OK’.
5. Click the ‘Layers’ Information Panel Icon.

6. In the Layers list, click the arrow

to the right of the ‘Schools (K12)’ layer.

7. In the Layer Options screen, select ‘Turn on/off layer Visualization’.
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8. In the Visualization Options screen, change the drop-down to ‘Custom Layer Style…’

9. Change the ‘Choose Symbology Type’ field to
‘Attribute’.
10. Set the ‘Pick an attribute to symbolize’ field to
‘Education Level’.
11. Set the Transparency to ‘20%’.
12. Change the Marker Size to ‘18 px’.
13. Change the Marker Style to ‘Circle’.
14. Change the Colours as needed by clicking on each
attribute class and choosing a colour.
12. Click ‘Done’.

The layer visualizations will be updated in the map window.

- End of exercise -
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Exercise 4: Provincial Layer Download
Use the Provincial Layer Download tool to acquire school locations and school districts for a particular
area.
1. In the ‘Data Sources’ tab, click the ‘Add Provincial Layers’ tool.
2. Under Education > Schools (K-12), put a check next to ‘Schools (K12)’ and Education > School
Districts, put a check next to ‘School Districts – Colour Filled’ and click ‘OK’.
3. In the ‘Export’ tab, click the ‘Provincial Layer Download’ tool.

4.

In the Data Download Service screen, under Layers, click the
Select All option or click each of the toggles for the School
Districts – Colour Filled and Schools (K12) layers.

5.

Click the ‘Prepare Order…’ button.

6. In the Order Details window:
 Set the Coordinate System to ‘BC Albers
(m)’
 Set the Format to ‘ArcView Shape’.
7. Set the Area of Interest to
‘Draw a Custom AOI’.
8. Click the ‘Draw a Custom AOI’
button.

9. The AOI Selector map window opens. In the search box, enter ‘Kamloops’ and hit the enter key.
10. In the Search Results screen, click the top result titled ‘Address: Kamloops, BC’.
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11. Click in the scale box and select the scale of ‘1:72,224’.

12. Click the ‘Select Area of Interest’ Information Panel Icon.
13. Click the ‘Draw Rectangle’ tool
similar to that shown below.

and click and drag in the map window to draw a rectangle

14. Once the shape has been completed, the Select Area of Interest window will display ‘Geometry
captured’. Click ‘Next’.
15. Click ‘Submit AOI’.
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16. The order details screen will reopen. The % of Max size will be updated (was previously 36%).

17. Enter your Email address and agree to the Terms and Conditions.
18. Click the ‘Submit Order’ button.
If you cannot see the ‘Submit Order’ button and there is no slider bar, you will need to press
the ‘Ctrl’ and ‘-‘ (minus) keys simultaneously to reduce the browser window text size.
19. Open your email application. You will receive two emails, the order submission email and the order
assembled email.
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20. In the order assembled email, click the provided URL to access your information. You may need to
enter your login credentials.

21. The Initiate Download screen will open. Click ‘Save as’, located under the Save options, to open the
save dialog box where you can download the zip file containing your data.

22. Click ‘Open’ to view your downloaded shapefiles.

- End of exercise –
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Exercise 5: Select by Query
Output a list of all Crown Tenures for Agriculture under lease.
1. Under the ‘Data Sources’ tab, click the ‘Add Provincial Layers’ tool.
2. Under Land Ownership and Status > Crown Tenure – All – Tantalis, put a check next to ‘Tenures –
Tantalis – Colour Filled’ and click ‘OK’.
3. In the ‘Find’ tab, click the ‘Feature Location’ tool.
4. Select ‘Municipality’ and click ‘OK’. Select ‘100 Mile House’ and click ‘OK’.
5. Click in the scale box and select the scale of ‘1:288,895’.

6.

In the ‘Find’ tab, click ‘Select by Query’ tool.

7. In the Query builder dialogue box, set the Data Source to
‘Tenures –Tantalis – Colour Filled’.
8. Set the Field to ‘Tenure Purpose’.
9. Set the Operators to ‘=’ sign.
10. In Field Value text box, type the word ‘AGRICULTURE’.

If you cannot see the text field, you can readjust the information panel width by clicking and
dragging the ‘information panel adjustor’ icon.
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11. Set the Spatial Filter option to ‘Current Extent’.
12. Click ‘Search’.

13. Notice the query found 22 results (your results may vary slightly as the number of results can change
based on screen size or updates to the data set).
Please do not click on any of the search results or your map view will change and the second part of
this exercise will not work. If you have changed your location on the map view return and do step 4
and 5 to zoom back to the correct extent 1:288,895 at 100 Mile House and then go to step 13.

14. To narrow the query to agriculture tenures that are leased, click the ‘Query’ Information Panel Icon.
15. Click the ‘Add Another Condition’ button.
16. Set the Field to ‘Tenure Type’.
17. Set the Operators to ‘=’ sign.
18. In Field Value text box, type the word ‘LEASE’.
19. Click ‘Search’. Notice the results this time are 10 (your results may vary slightly as the number of
results can change based on screen size or updates to the data set).
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20. In the Query Results screen, click the ‘Options’ button and select ‘Switch to Table’.

21. In the Table View screen, click the ‘Options’ button and select ‘Export to XLSX’.

22. In the confrimation window, click ‘OK’. When the download window appears, click ‘Open’. The
results will open in Excel.

- End of exercise –
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Exercise 6: Filter by Query
View all vegetation polygons around Prince Rupert over 325 years old.
1. In the ‘Find’ tab, click the ‘Feature Location’ tool.
2. Select ‘Municipality’ and click ‘OK’. Select ‘Prince Rupert’ and click ‘OK’.
3. Click in the scale box and select the scale of ‘1:36,112’.

4. In the ‘Data Sources’ tab, click the ‘Add Provincial Layers’ tool.
5. Under Forest Grasslands and Wetlands > Vegetated Land Cover, put a check next to ‘Vegetated
Land Cover – Projected Age’ and click ‘OK’.
6. In the ‘Find’ tab, click the ‘Filter by Query’ tool.
7. In the Filter builder dialogue box, set the Data Source to
‘Vegetated Land Cover – Projected Age’.
8. Set the Field Name to ‘Projected Age’.
9. Click the ‘Operators’ to the Greater Than ‘(>)’ sign.
10. In Field Value text box, type the value ‘325’.
If you cannot see the text field, you can readjust the information panel width by
clicking and dragging the ‘information panel adjustor’ icon.
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11. Click ‘Filter’. The map will now only display vegetation stands that are over 325 years in age. All
vegetation stands equal or less than 325 years old have been filtered from the map.

- End of exercise –
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Appendix B: Training Videos – Under Construction
Training videos are currently in production. This section will be updated once the training videos are
available.
Data download - https://www.youtube.com/watch?v=kkui5GQzB3E&feature=youtu.be
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Appendix C: Finding Content on the DataBC Site
The DataBC Geographic Services web site http://www2.gov.bc.ca/gov/content/data/geographic-dataservices is the starting point for a multitude of services.

Data Distribution Service
Select and request datasets in a specific file format. This specialized service allows data transformation
as part of the ordering process. From different formats and projections, users can specify a specific area
and have data clipped, transformed, zipped and shipped.

Web-based Mapping (iMapBC and Hectares BC)
Visualize and analyze the wealth of B.C. geographic information using a variety of web-based map tools
and map services.

Location Services (B.C. Physical Address Geocoder, Geomark Web Service, BC
Geographical Names Web Service)
A suite of web services that locate things such as civic addresses, areas of interests, place names and
routes from point A to B.
These services reference authoritative data and are designed to be integrated into business workflows
and applications.

Topographic Data
Topographic data provides detail on British Columbia's terrain, elevation and land features. The
topography of B.C. is used to create maps of the provincial land base.
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Land Use
The Provincial Government develops, manages and maintains the fundamental datasets for determining
land ownership, rights and jurisdiction in British Columbia.
Land that can be owned in B.C. is divided into parcels. Land parcels may be owned by governments,
companies, organizations or persons. A cadastre is a register that describes the ownership, location and
dimensions of land parcels.

Digital Imagery
Imagery provides a sense of the current state of a place, as well as a view into its past condition. Visual
data is critical to measuring cumulative effects on the land of British Columbia.
High-resolution images are useful for mapping, research, emergency planning and natural resource
management. Government agencies, industry and the general public can access digital versions of any of
these images, which provide visual context about how the province has developed and changed.
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